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1. REEKLED
AN K A8 PIC32MX470F512L #:45#iH (Plug-In Module, PIM) %2 # 5555 Explorer
16/324k LIJLED. HZ(EE, S WNEBY “FREKAFMEL” .

// PIC32MX470F512L Configuration Bit Settings
// 'C' source line config statements -#—— {EZNLE11T

// DEVCFG3

// USERID = No Setting

#pragma config FSRSSEL = PRIORITY 7 // Shadow Register Set Priority 7
#pragma config PMDLIWAY = ON // Peripheral Module - One Reconfig
#pragma config IOLIWAY = ON // Peripheral Pin Select - One Reconfig
#pragma config FUSBIDIO = ON // USB USID Selection - Port Function
#pragma config FVBUSONIO = ON // USB VBUS ON Selection - Port Function

// DEVCFG2

#pragma config FPLLIDIV = DIV_12 // PLL Input Divider - 12x
#pragma config FPLLMUL = MUL 24 // PLL Multiplier - 24x

#pragma config UPLLIDIV = DIV 12 // USB PLL Input Divider - 12x
#pragma config UPLLEN = OFF // USB PLL Disabled and Bypassed
#pragma config FPLLODIV = DIV 256 // Sys PLL Output Divide by 256

// DEVCFG1

#pragma config FNOSC = FRCDIV // Oscillator - Fast RC Osc w/Div-by-N
#pragma config FSOSCEN = ON // Secondary Oscillator Enabled

#pragma config IESO = OFF // Internal/External Switch Over Disabled
#pragma config POSCMOD = OFF // Primary Oscillator Disabled

#pragma config OSCIOFNC = OFF // CLKO on OSCO Pin Disabled

#pragma config FPBDIV = DIV_8 // Peripheral Clock Divisor: Sys Clk/8
#pragma config FCKSM = CSDCMD // Clock Switch Disable, FSCM Disabled
#pragma config WDTPS = PS1048576 // WDT Postscaler 1:1048576

#pragma config WINDIS = OFF // Watchdog Timer is in Non-Window Mode
#pragma config FWDTEN = OFF // WDT Disabled (SWDTEN Control)

#pragma config FWDTWINSZ = WINSZ 25 // Watchdog Timer Window 25%

// DEVCFGO

#pragma config DEBUG = OFF // Background Debugger Disabled

#pragma config JTAGEN = OFF // JTAG Disabled

#pragma config ICESEL = ICS_PGx2 // ICE/ICD Comm Channel PGEC2/PGED2
#pragma config PWP = OFF // Program Flash Write Protect Disabled
#pragma config BWP = OFF // Boot Flash Write Protect Disabled
#pragma config CP = OFF // Code Protect Disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h> --&—— HEHENFE1.2T
#define LEDS ON OFF 0x55 -€—— i§&WHE1.375
int main(void) {

// Port A access &—— iESNE1.4T

TRISA = 0x0000; // set all port bits to be output
LATA = LEDS ON OFF; // write to port latch

return 0;
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1.1 EEAL
Microchip 23 F B A L B 2 /7 2%, FLApI0az nl B T8N/ sk ik & 23 Th ek

Ve WK ETREREL, BT, SE AR BT |

1.1.1 B E WA E AL

TR R AR LI

« RGB/EFE— 2D A G IR SRRV . WA R, A AT
FETLZAE 1T WHAEOLT, JFARME T i R o sl B A ARG 40 R
#pragma config FNOSC = PRI
#pragma config POSCMOD = HS

o F 100 E I 28— DA D N AR e I g . XRERT B L B AR E L. R A
FARFL U R

#pragma config FWDTEN = OFF

o ARG LRI ——AE W ZEI KPR CR Y o XA AT B OR 257 77 i 7 F) 6 £ 0 o 7)o
A RARRS A T

#pragma config CP = OFF

ﬁﬁﬁﬁﬁﬁ?ﬁﬁ%ﬁﬁ: G AE A 78 ) 46 B IMCUD I, o] BE 7 B B AR A B
7. 155 W B K850 M 7 A N G B AL A Yn 5 A Th e w3 FH 584 g 5 A
http://www. mlcrochlp com _ 8 ZAH B 1 5 Tt

A RS AR B E2E R, 152 W MPLAB XC32 %8845 F I U~ 3C A
MPLAB XC32 Installation Directory/docs/PIC32ConfigSet.html
1.1.2 W BB

7EMPLAB X IDE 1, W]# ] Configuration Bits (ECEf7) & & H MK BixLefr, i
% £ Window>PIC Memory Views>Configuration Bits (% 11 >PICTZ %2540 &> B 1)
FHZE L,

E1: REHN

Scarch Results | Configuration Bits 5 | o
Address  Name Value Field Option Category Setting
La DEVCFG3 FOO0TFFFF USERID -
L8 FSRSSEL PRIORITY_7 Shadow Register Set Priority Select SRS Priority 7
DMDLIWAY ON Peripheral Module Disable Configquration Allow only one reconfiguration
@"\ IOL1KAY oN Peripheral Pin Select Configuration Allow only one reconfiguration
—‘—| FUSBIDIO ON USB USID Selection Controlled by the USE Module
Iiert Source Code in Editor -
EVBUSONIO ON USB VBUS ON Selection Controlled by USE Module
1FCO_2FF4 DEVCFG2 FFFFFFFF FPLLIDIV DIV _12 PLL Input Divider 12x Divider
FPLIMUL MUL_24 PLL Multiplier 24x Multiplier
UPLLIDIV DIV_12 USB PLL Input Divider 12x Divider
UPLLEN CFF USB PLL Enable Disabled and Bypassed
FPLLODIV DIV 256 System PLL Output Clock Divider PLL Divide by 256
LFCO_2FFé DEVCFGL FFFFFFFF ENOSC FRCDIV Oscillator Selection Bits Fast RC Osc w/Div-by-N (FRCDIV)
FSOSCEN oN Secondary Oscillator Enable Enabled
IESO on Internal/External Switch Over Enabled
POSCMOD OFF Primary Oscillator Configuration Primary osc disabled -
Memory | Configuration Bits ~ | Format Read/Wirit - ( Generate Source Code to Outout D

SERTHEREN, $idimain () ATEEEHE pragma A5 HIAL B AL KIS, FE8d
Insert Source Code in Editor (Eﬁiﬂ%&qﬂﬁa)\ﬁﬁﬂ) KEbr. 8, Edn] g
Generate Source Code to Output (4 Z 5 H EMREY) , AR5 pragma thiE4
M Output (i) & O & HI 2 &R .
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1.2 L ff<xc.h>

AR S SO SO IR SO A RIARAD U 1) G 13 25 B SRR e O Th BE . AT TE MPLAB XC32 %2 %%
HZMpic32mx/include F Hk N3 BIA L SCHF0 HoAd Sk S04

IR AT AR B I BB R B AN %2, UME xc . h 8 M IERf #8405 e 2k o0tk . 38
¥ 2 AR e 1Sk SO A TR IS AR R, B S BRI A i A

1.3 NLEDMHEXFE

nE i, E5 ANLED FE CIRE 4 fik % (LEDS_oN _oFF) , HEILED D3.
D5. D7f1D9¥ 5, LEDD4. D6. D8FID10K4E K. < Explorer 16/32 4 (&
BB ED KR, E2 WEB.STT “IKEUIH R E Explorer 16/321R” .
1.4 smHAY5E
BAEBCF O 5] AT e S AN /O B IR A« B R ARl B /0, 2510 HAh 4k
Wo Ak, AIERARRANE A AR LI P TUE L CA . X AR A T g i H 1)
pic32mx/include/proc T &R E LA e T HR £ F1 5 3k R WIR 28 5] K 43
B, ES B ARSI B s T
SFFAN A EIRG], owm O AG S BRI AN R . BN, G 0 ABA B0,
IR A S BRI 1O. X T DA BAL/O R #s4F, i%E (bRl DyRE (i,
ffF ADxPCFT 77 /728 ) KB TREL T IO HAE
FAE 5] R B AR BCFE IO NG T (PORT) BUBIAF Y (LAT) FAF#E. il A
LATA. N FEportvaluellfd, VMEREEIRELSBFE -

LATA = portValue; // write to port latch
BeAh, A —A AR TR g B g R NS 2, ERCONTRIS 278t . A
TR BI AT TRISA. WEAE N 0 ARSI M, KA E N 1N S
BN XFAIRB:

TRISA = 0x0000; // set all port bits to be output
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2. {HFHIERT REUE LED [N 4%

ARBIHE bR A B 2l BT B . AR A 5 LED, &4 LED A2 & A
Mo SIS L R,

// PIC32MX470F512L Configuration Bit Settings

// 'c!

// DEVCFG3
// USERID = No

#pragma
#pragma
#pragma
#pragma
#pragma

config
config
config
config
config

// DEVCFEFG2

#pragma
#pragma
#pragma
#pragma
#pragma

config
config
config
config
config

// DEVCFG1

#pragma
#pragma
#pragma
#pragma
#pragma
#pragma
#pragma
#pragma
#pragma
#pragma
#pragma

config
config
config
config
config
config
config
config
config
config
config

// DEVCFGO

#pragma
#pragma
#pragma
#pragma
#pragma
#pragma

config
config
config
config
config
config

source line config statements

Setting

FSRSSEL = PRIORITY 7 // Shadow Register Set Priority 7
PMDLIWAY = ON // Peripheral Module - One Reconfig
IOL1WAY = ON // Peripheral Pin Select - One Reconfig
FUSBIDIO = ON // USB USID Selection - Port Function
FVBUSONIO = ON // USB VBUS ON Selection - Port Function

FPLLIDIV = DIV 12 // PLL Input Divider - 12x
FPLLMUL = MUL 24 // PLL Multiplier - 24x

UPLLIDIV = DIV 12 // USB PLL Input Divider - 12x
UPLLEN = OFF // USB PLL Disabled and Bypassed
FPLLODIV = DIV 256 // Sys PLL Output Divide by 256

FNOSC = FRCDIV // Oscillator - Fast RC Osc w/Div-by-N
FSOSCEN = ON // Secondary Oscillator Enabled

IESO = OFF // Internal/External Switch Over Disabled
POSCMOD = OFF // Primary Oscillator Disabled

OSCIOFNC = OFF // CLKO on OSCO Pin Disabled

FPBDIV = DIV _8 // Peripheral Clock Divisor: Sys Clk/8
FCKSM CSDCMD // Clock Switch Disable, FSCM Disabled
WDTPS = PS1048576 // WDT Postscaler 1:1048576

WINDIS = OFF // Watchdog Timer is in Non-Window Mode
FWDTEN = OFF // WDT Disabled (SWDTEN Control)
FWDTWINSZ = WINSZ 25 // Watchdog Timer Window 25%

DEBUG = OFF // Background Debugger Disabled

JTAGEN = OFF // JTAG Disabled

ICESEL = ICS PGx2 // ICE/ICD Comm Channel PGEC2/PGED2
PWP = OFF // Program Flash Write Protect Disabled
BWP = OFF // Boot Flash Write Protect Disabled

CP = OFF // Code Protect Disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h>

#define LEDS_ON_OFF 0x55
#define LEDS_OFF_ON OxAA

void delay

{

int

(void)

n = 50000;
while (n>0)

{n--;1}

© 2018 Microchip Technology Inc.
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int main(void) {

// Port A access
TRISA = 0x0; // set all port bits to be output

while (1) { -—— FHBNE21%
LATA = LEDS ON OFF; // write to port latch

// delay value change -#—— {EZNE2.27
delay ()

LATA = LEDS OFF ON; // write to port latch

// delay value change
delavy () ;
}

return -1;

}

21 while() EHNZEME

BAS G A ERILED KA, TR —H 0 N B Eportvalue I—AME, 2
JEEEI I 3 AR R — M RME. H T while (1) { ) #ATIEH.

IR ERBOR ], W ERE AR, EOywhile RPN EHE AN SR B, R

2.2 delay() ¥

HFHATHEEA RZHIB N N2 S LED W INREE&S B NRREE S, FHtE
B HATEE . Bldelay () Emain () ZRIBHATHHAE X, fEmain () AR
PR

HE: ARG, SIER R (B -00) o A RIEIBALD
PAT I FHABTVE, ES T — AR
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3. fEH e NIER7E LED E BoRiE T4

P N1 Sl ey N K AMETET B 2 i e 15 DA = Bl e 1 LS RN O KT RS 00 B (B2
PATHERA ], AHR SRR P gl AN 6] o Dy S iX — [ A, R A A A% 52 I
Sk, FERRUCOR AN, SRR ARG N JF BoRELED L.
APl T N E R &, OV EFE T A PIC32 MCU R £F— 2, I UE E i &
(BE2AFR G D 34, o HJCRR W E I 5 70 Akt . HAd 2% 1 2 I 25 th T LUH
TR, (HZ AR AR AT AT R — AN &, WU 0. S IN B ARRS LAt
TR,

// PIC32MX470F512L Configuration Bit Settings

// 'C' source line config statements

// DEVCFG3

// USERID = No Setting

#pragma config FSRSSEL = PRIORITY 7 // Shadow Register Set Priority 7
#pragma config PMDLIWAY = ON // Peripheral Module - One Reconfig
#pragma config IOLIWAY = ON // Peripheral Pin Select - One Reconfig
#pragma config FUSBIDIO = ON // USB USID Selection - Port Function
#pragma config FVBUSONIO = ON // USB VBUS ON Selection - Port Function

// DEVCFG2

#pragma config FPLLIDIV = DIV 12 // PLL Input Divider - 12x
#pragma config FPLLMUL = MUL 24 // PLL Multiplier - 24x

#pragma config UPLLIDIV = DIV_12 // USB PLL Input Divider - 12x
#pragma config UPLLEN = OFF // USB PLL Disabled and Bypassed
#pragma config FPLLODIV = DIV 256 // Sys PLL Output Divide by 256

// DEVCFG1

#pragma config FNOSC = FRCDIV // Oscillator - Fast RC Osc w/Div-by-N
#pragma config FSOSCEN = ON // Secondary Oscillator Enabled

#pragma config IESO = OFF // Internal/External Switch Over Disabled

#pragma config POSCMOD = OFF // Primary Oscillator Disabled

#pragma config OSCIOFNC = OFF // CLKO on OSCO Pin Disabled

#pragma config FPBDIV = DIV 8 // Peripheral Clock Divisor: Sys Clk/8
#pragma config FCKSM = CSDCMD // Clock Switch Disable, FSCM Disabled
#pragma config WDTPS = PS1048576 // WDT Postscaler 1:1048576

#pragma config WINDIS = OFF // Watchdog Timer is in Non-Window Mode

#pragma config FWDTEN = OFF // WDT Disabled (SWDTEN Control)

#pragma config FWDTWINSZ = WINSZ 25 // Watchdog Timer Window 25%

// DEVCFGO

#pragma config DEBUG = OFF // Background Debugger Disabled

#pragma config JTAGEN OFF // JTAG Disabled

#pragma config ICESEL = ICS_PGx2 // ICE/ICD Comm Channel PGEC2/PGED2
#pragma config PWP = OFF // Program Flash Write Protect Disabled
#pragma config BWP OFF // Boot Flash Write Protect Disabled
#pragma config CP = OFF // Code Protect Disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h>

#include <cpOdefs.h> -——— FEENE3AT
#include <sys/attribs.h> -

© 2018 Microchip Technology Inc. DS50002509B_CN 7 17T
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// CORE TICK RATE = FOSC/2/TOGGLES PER SEC

// FOSC/2 = Core timer clock frequency = 8MHz/2=4MHz

// TOGGLES_ PER SEC = Toggle LED x times per second; x=5
#define CORE TICK RATE 800000u

// Interrupt function -——— {EZNE3.27

void  ISR( CORE TIMER VECTOR, IPL2SOFT) CTInterruptHandler (void)
{

// static variable for permanent storage duration

static unsigned char portValue = 0;

// variables for Compare period

unsigned long ct count = CPO_GET COUNT () ;

unsigned long period = CORE TICK RATE;

// write to port latch

LATA = portValue++;

// update the Compare period
period += ct count;
_CP0O_SET_COMPARE (period) ;

// clear the interrupt flag
IFSOCLR = IFSO CTIF MASK;

int main(void) {
unsigned int stat gie, cause val;

// Disables interrupts by clearing the global interrupt enable bit
// in the STATUS register.
stat gie = builtin disable interrupts();

// Port A access
TRISA = 0x0; // set all port bits to be output
LATA = 0x0; // clear all bits

// Configure the core timer -&—— {HFHNE3.3Y
// clear the CPO Count register

_CPO_SET COUNT (0) ;

// set up the period in the CP0O Compare register
CP0_SET COMPARE (CORE TICK RATE);

// halt core timer and program at a debug breakpoint
_CP0_BIC DEBUG( CPO_DEBUG_COUNTDM MASK) ;

// Set up core timer interrupt --—— HEHNE34T
// clear core timer interrupt flag

IFSOCLR = IFSO CTIF MASK;

// set core time interrupt priority of 2
IPCOCLR = IPCO_CTIP MASK;

IPCOSET = (2 << _IPCO_CTIP_POSITION);

// set core time interrupt subpriority of 0
IPCOCLR = IPCO CTIS MASK;

TPCOSET = (0 << TIPCO CTIS POSITION);

// enable core timer interrupt

TECOCLR = IECO CTIE MASK;

IECOSET = (1 << _IECO CTIE POSITION) ;

DS50002509B_CN 5811 © 2018 Microchip Technology Inc.
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// set the CP0 Cause register Interrupt Vector bit
cause val = CPO GET CAUSE () ;

cause val |= CPO _CAUSE IV MASK;
~CP0_SET CAUSE (cause val);

// enable multi-vector interrupts
INTCONSET = INTCON MVEC MASK;

// enable global interrupts
__builtin enable interrupts();

while (1) ;

return -1;

© 2018 Microchip Technology Inc. DS50002509B_CN 59 71T
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31 HAthskoeft

Frxc.hdb, BFAEHA KL CH: cpodefs.h (I TCP0%) Msys/attribs.h
(HFISRZ) &

3.2 FFEH

KRB EH ISR ISR (v, IPL) ¥ CTInterruptHandler () 2N MR %, Hh
v NAZER S PR FE, TPLATWIEd (2) , BUafRyTiiE GEEEA) RoR
AN IPL2SOFT. fIXISRIEL(ER, HS W (MPLAB® XC32 C/C++ % 1% # i /' &
F§) (DS50001686G_CN) 1] “Hilfi” —=,

TERRWT R EF, S portvalue i H E/RTELED k.

THHRR W, U5 N CPO LR A 735 . LA A7 28 v M ELKS 5 P9 A% 8 I 38 1 R SRl
BEATHRAL, BAFEAE T — ANl A% E i 8 A M AiE AT LA CPO_GET COUNT ()
.

e, W EEERR .

3.3 HNiEERSHKE

32 A% E I 2RV AA N L BN 0. A A2 45 X B CORE_TICK RATE HIWIZA{E. 4
P A% € IR 59 B LU I, K v BB

12 S E N E#%W*Z?Eﬁ%%ﬁ%?ﬂ"tﬁ AL,

RN ERBHELEE, E3 0 (PIC32RFISETFMY W25 “i MAK® %
(132441 CPU” (D861113E_CN)

3.4 NiZER SR

T E A% E B 4 A 7 A LN D IR

fEmain fRRSEEMELL, {4  builtin disable interrupts () ZEiE&FdH. £
while (1) fE¥ 2 HI, 1 builtin enable interrupts () LiF&FHW.
WVEET%%*UTH AR GAIE e hifin)D) FHIZEFRR.

HRITAR e AN L e A AR AT R E . A B S e 2 HR T R B A e 2
(2) LA,

P A% A2 B 4 A 22 ) & Hp B4 FH 28 10F 22k e V. CPO Cause &7 A7 HH 11 A B 1) &4 4 A
A CPO L AT I E .
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4. FH ADCTELED L B/rHAi#81E (MPLAB HARMONY)

A TR 5 745 3 A5 AR [R] ) 3842 DL RS 11 A LED o B AEAS R, R4 P R _E i s
AREIEL I B (RB2/AN2) SR AtiE4 # s (Analog-to-Digital Converter, ADC)
N, SRIGRAT I BoRTELED L.

RIGTFT3hIME, 218 H MPLAB Harmony 4 /. F#MPLAB Harmony 4 i # {4
FEZL, WIdkA

http://www.microchip.com/mplab/mplab-harmony

MPLAB Harmony i & # (MPLAB Harmony Configurator, MHC) & H +MPLAB
Harmony GUI & [JMPLAB X IDE#fiff. iZ4diff 7 7E MPLAB X IDE > . Tools>Plugins
(T E>¥EMF) fAvailable Plugins (n] FHGfF) iR N2, A R 224611
BLAER, 152 WMPLAB X IDE#).

AR BIHET Windows® i BL R #8122 R [ adc_pot vl
C:\microchip\harmony\vl 10\apps\examples\peripheralladc\adc pot
41 7EMPLAB X IDE+flJ#—1MPLAB Harmony i H
NATRBIBCE DL R EAE .

TEMPLAB X IDE 1, 3% File>New Project (SC/4>##E#MH) .

& 2: #iE2 MPLAB® HARMONY 1 F — 5% 1
-
ﬁ Mew Project [=2]
Steps Choose Project
1. Choose Project Q, Filter:
2. e
Categories: Projects:
| Ly Microchip Embedded m 32-bit MPLAB Harmony Project
- )} Other Embedded [d Standalone Project
)\ Samples m Existing MPLAE IDE v& Project
) [ Prebuilt (Hex, Loadable Image) Project
[l User Makefile Project
[ Library Project
Description:
MPLAB® Harmony Project Wizard
< Back Finish Cancel ] [ Help
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i fx Harmony #6424 19 #5222 () MPLAB Harmony .

A 3: ¥ MPLAB® HARMONY 5  — 5B 2
¥4 New Project @

Steps Name and Location

1. Choose Project . A - g |

S e C ————2 Harmony Path: C:\microchiptharmonyw1_10
Project Location: C:\microchiptharmony'w1_10\apps ]
Project Name:
Project Path: C:microchiptharmonyy 1_10%apps\Example4\firmware \Example4.X

Configuration Name: explorer1632
Device Family: All - Target Device: ( |PIC32MX470F5120 P

Mote: All projects have recommended optimizations set by default.

< Back ext > Finish ]| Cancel || Help
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42 FEMPLAB HarmonyJiH

MRAEE KT H B E, MHCITITI RS A w5 2 . DA 6 R BRI SCAR SRR

o FEAGI Y, ANEER I B i B AT AR AT B

fLE ADCIKshFE T (W6 ) FitkZi ¢t (Board Support Package, BSP) (11

B 7R
K 4: MPLAB® HARMONY 15 H #1MHC
Projects # | Files |Classes | [=] | Start Page ﬁ|'ﬁ' MPLAB X Store ﬁ| MPLAB® Harmony Configurator 3

B Exampled
-- Header

E" Loadabl

G-[i§ Important Files

/ PP | i) [ 2T | T

Options |Clnck Diagram X |Pin Diagram X |Pin Settings *

Files

.. Linker Files MPLAE Harmony & Application Configuration
-- Source Files --ﬁ.pplicaﬁon Configuration

ﬁ Libraries --Harmany Framework Configuration

= --ESP Configuration

---Third Party Libraries
--Deuice & Project Configuration

&l 5: HARMONY HE 28 g & —— A b

Start Page ﬁ|'i-_ll,'!" MPLAB X Store ﬁ| MPLAB® Harmony Configurator 32

e

Ao |20 | T

Options |Clock Diagram X IPin Diagram X IPin Settings  *

L‘i}-System

Services

=-Clock

- [¥] Use Clack System Service?
é----SElECt Service Mode |STATIC -
é----Launch Clock Configurator
é--clcck Configurator Settings
- *%5%5% Al settings listed here can be configured using the Clock Configurator ===
- [] et PBDIV {Dverride FPBDIV)
-Peripheral Clock Buzs Divisor (1-8) |DIV_2
- [] Enable Reference Clock REFCLEO
-Primary Osdllator Input Frequency (Hz) 8000000
-Secondary Osdllator Input Frequency (Hz)
[=+Caloulated Clock Frequendies
----- System Clock Frequency (Hz) [96000000
é----Peripheral Bus Clodk Freguency (Hz) | 48000000
E----LISE PLL Clock Frequency (HZ) 96000000

L s
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K 6: HARMONY #E 27 B —— ADC IR zh 2%

-H' MPLAE ¥ Store ﬁ| MPLAB® Harmony Configurator =

Start Page 2
LB P |4 |20 |
Options |CIockDiagram x IPin Diagram X |Pir1 Settings X
=+ Drivers
£1-ADC

£+ [¥] Use ADC Driver?
~Driver Implementation [STATIC
[+-Mode Options
[#-Clock Options
[=-Sampling Options
Er Enable Auto Sample?
 Auto Sample Time (iTAD) [31
[7] Stop Conversion on the First ADC Interrupt?
Sampling Mode | ADC_SAMPLING_MODE_MIIXA -
+- [] Enable Scan Mode?
E-----Numl::nar of Samples per Interrupt | ADC_16SAMPLES_PER._INTERRUFT =

[#-Caonversion Options
[#-Other Options

[#-Megative Input Options
- *%=%% Infg: Only two dedicated channels are supported (one for each MUX) ===
~Mumber of Analog Channel Instances | 1
=+ [¥] ADC Analog Channel Instance 0
él--SEIect Type
‘... [#] Dedicated Channel
E----‘Sv.=.|ect Dedicated Analog Channel ADC_INPUT_POSITIVE_ANZ

7. ADC i H IR &

StartPage = '-;\1!" MPLAE X Store ﬁ| MPLAB® Harmony Configurator®
L B[P | |20 | R

Options™ |C|ock Diagram X I Pin Diagram I Fin Settings =

MPLAE Harmony & Application Configuration
--ﬁ.pplicaﬁon Configuration

--Harmony Framework Configuration

fiJ--BSP Configuration

- [7] Use BSP?

é}--SeIEtt BSP To Use For PIC32MX470F 5121 Device
[T] P1C32 Bluetooth Audio Development Kit
= PIC32M¥470F512L PIM wExplorer 16
i [T] PIC32MY USE Starter Kit 3

[#-Third Party Libraries

[+-Device & Project Configuration
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&|8: ADC i H 5| & &

StartPage | MPLAB X Store 58| MPLAB® Harmony Configurator= s
L B ()| atper) |20 |
| Options* I Clock Diagram % I Fin Diagram {Piﬂ Settings X'
Pin Name Voltage Function Direction Latch Open Drain Mode
Talerance (TRIS) (LAT) (ODC) {AMSEL)
17 RAD 5V LED_1 Out Low [ Digital
38 RA1 5V LED_2 Out Low [ Digital
58 RAZ 5V LED_3 Out Low [ Digital
59 RA3 5y Low | [ Digital
&0 RA4 5V low | [ Digital
61 RAS 5y low | [ Digital
g1 RAG 5y low | [ Digital
92 RAT 5V Low | [ Digital
23 RAS n/fa [ [ Analog |

© 2018 Microchip Technology Inc.
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4.3 ERAREAGRER AR SO

F e EIR % KW B 56 MHC )5, 1% ¥y MPLAB Harmony Configurator (MPLAB Harmony
FoE %) 10K L Generate Code (4:/fUi%) 44,

e Ol= g

iagram Pin

RAFBCE (K9 FRAMIE S (E10) .
& 9: PRAFHLE

-2 Modified Configuration @

Current configuration has been medified. Do you want to save it before file generation?

C:\microchiptharmony'w1_10\apps\Example4\firmware\src\system_configiexplorer 1632\explorer 1632.mhc

[ Don'tSave ﬂ Save DI Save As

& 10: A g B AR

-2 Generate Project @
Merging Strategy
Generated code merging strategy: | Frompt Merge For All User Changes -
Description:

The user will always be prompted with a merge window for all generated files that
contain user modifications.

/| Create a backup of the current project state (recommended)

/| Enable recommended compiler optimizations {if not set)

Generate | | Cancel
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MPLAB Harmony A4 i () AR RS 2 B e A 1, anl& 11 s N AR 7 S Capp . h H
app.c) & NARRE G SO
AR HADCIEZERE, B2 N (PIC32 RIS E TN ME17 5 “10 BBt
#&” (DS61104D_CN) .

JBi3 MHC 4 sk 1R AS Y ADC T H #%

11

Et

Projects 2 | Files |Classes |
EI@

=} Header Files

=g app
I'I:'_;-I app.h
E} system_config
El explorer 1632
-- framework
>|F|_j system_config.h
E] system_definitions.h
{5 bsp
w5 framework

E}--ﬁ' Important Files
Linker Files
E-(gg Source Files

=g app

,lEI app.c

E] main.

E} gystem_config

EI explorer 1632

-- framework
E] system_exceptions.c
>|E‘| system_init.c
>|E‘| system_interrupt.c
IEI system_tasks.c

&[5 bsp

EEI"' framework

-(gg Libraries

. % of o fo ) binfframework fperipheral (PIC32MN470F 5121 _peripherals.a
-t Loadables

© 2018 Microchip Technology Inc.
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44 app.hBEXUERINREG

app . BRI Ot i, W R os. FRTERMI < >4Ek, FoRClilkk. Sasmm
RIG LA RIR .

/********************************************************************

MPLAB Harmony Application Header File

<See generated app.h file for file information.>

************************************k********************************/

//DOM-IGNORE-BEGIN

/*************‘k*‘k****************************************************

Copyright (c) 2013-2014 released Microchip Technology Inc. All rights
reserved.

<See generated app.h file for copyright information.>

**‘k*‘k*‘k*‘k*‘k**‘k**‘k***************************************************/

//DOM-IGNORE-END

#ifndef APP H
#define APP H

#define ADC_NUM SAMPLE PER AVERAGE 16

// R i I b I I I I i b b b b b b I I b I i b b b I b b S b b b I b b I I b b I I b b b b b b i I b b b I b b b b b b i
// B I b I I I I i b b I b b b I I b b i b b b e I b b S b b b I I b I I b b I I b b b e b b b I I b b b I b b b b b b b i
// Section: Included Files

// Ak hkhk kA hkhkhkhkhkhhhkhAhhhkhkhkhhkkhkhkhhkhkhkhkhhkkhkhkhhkhkhkhkhkhkhkhkhrhhkhkhdhkhhkhkrhhkkhkhkrhkhkhhxkk*xx*x

// Ak kA hk kA hkhkhkh Ak kA hhkhk kA hkhk Ak h Ak kA hhkrhkhkhkhk Ak kA hhkhkhkrhkhkrkhhkhkhkrhkhkrhkhhkkhkkxkkxk*k

#include <stdint.h>

#include <stdbool.h>

#include <stddef.h>

#include <stdlib.h>

#include "system config.h"
#include "system definitions.h"

// DOM-IGNORE-BEGIN
#ifdef  cplusplus // Provide C++ Compatibility

extern "C" {

#endif
// DOM-IGNORE-END

// R R R B I R R R R R R R R R b R b b b b b b b 2 S

// kA hkhk Ak kA hhkhk kA hkhk Ak hhkhk kA hhkhkhhAhhkhkhkhkrhkhkhkhkrhhkrhkhkhkhkrhkrhhkhkkrhkhkrhkhkhkkhkxkkxk*k

// Section: Type Definitions
// R S S S R RS I I I e I I I R I I I I I I b I I b I e b b b I i b b b b b b b

// KA A KA AR AR A AR A AR A AR AR A AR A AR AR A AR A A KR A AR AR A AR A A A AN A AR A AR A A A AR A AR Ak, K

// R R R I e B I R R R R R R R b R R b b b b b b 2 ]

/* Application states

Summary:
Application states enumeration

Description:
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This enumeration defines the valid application states. These
states determine the behavior of the application at various times.

*/

typedef enum
{
/* Application's state machine's initial state. */
APP STATE INIT=0,
APP_ADC_WAIT,
APP ADC DISPLAY

} APP STATES;

// Ak hkhk kA hkhkrhkhkhhkdAhhkhh bk hhkdhhkhhkhkhhkhkhhkrhkhkhhkrhhkrhkhkhhkrhkrhhkhkkrhhkrhhkhkhkxhkxk*k

/* Application Data

Summary:
Holds application data

Description:
This structure holds the application's data.

Remarks:
Application strings and buffers are be defined outside
this structure.

*/

typedef struct
{

/* The application's current state */
APP STATES state;

/* Values for the conversions */
int potValue;
int ledMask;

} APP_DATA;

// R R R B b I R R R I R R R R R R b b b b b b b b b b b 2 S

// Ak kA hk kA hhkhkh Ak kA hhkhk kA hhkhkhk Ak kA hhkrhkhkhkhkdrhkhkrhhkhkhkrhhkrhhkhkhkrhkhkrhkhkhkhkxkkxk*k

// Section: Application Callback Routines

// R R I b I b S b b S SR S SE I b b b b Sh b b Sh S b b 2b b b 2h S Sb I Sb b b Sb b S db S Sb e Sb b I 2b S Ib b S 2b I 2b db b 2 3

// KA A KA AR AR A A A A A A A AR AR A A A A AR A KR A AR A A KR A AR AR A AR A AR A AR A AR AR A AR AR A AR Ak, K

/* These routines are called by drivers when certain events occur.

*/

// R I b b I b S b b 2 S S SE I b b b b Sb b b Sh S Sb I 2b b b 2h S S b Sb db b Sh b S db S Sb e Sb b I 2b S Sb S Sb S 2b db b 2 3

// R R I S I b S b S SR S SE b S b Sb b b Sb b b Sh b Sb b I 2b b b 2h S b b Sb 2b b Sh b S b S db b Sb b I 2b R S Sb b S 2b I Sb db b 2 Y

ion: i i itializati i u i
// Section: Application Initialization and State Machine Functions
// KAk kA Ak hk kA Ak kA Ak hk kA hk bk hk kA hhk kA hk ko hk kA ko hkhkhkhk ko kA dhkhkhkhkhkhhkhkrhhkkhkhkrhhkhkkxhhk k%

// R I R I R R R R R R R R R b R b b b b b b 2 ]

/********************************************************************

Function:
void APP Initialize ( void )

Summary:
MPLAB Harmony application initialization routine.

<See generated app.h file for app init information.>
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*/
void APP Initialize ( void );

/***********k***************k*********k*********************************

Function:
void APP Tasks ( void )

Summary:
MPLAB Harmony Demo application tasks function

<See generated app.h file for app tasks information.>
*/

void APP Tasks( void );

#endif /* APP H */

//DOM-IGNORE-BEGIN
#ifdef  cplusplus
}

#endif
//DOM-IGNORE-END

/********************************************************************

End of File
*/
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4.5 app.cBH/ERRIG
app. c BB C AL iR, TR, BRI < >R, FoReMkk. Simg
A 1D RN o7

A EEATARAS, R AL DU P AT s o SR AT A B 5 3R] AR SO A BY D) AH N2 9 28 9
b 210G 4 2 7

/**************k******************************************************

MPLAB Harmony Application Source File

<See generated app.c file for file information.>

********************************************************************/

// DOM-IGNORE-BEGIN

/********************k****k**k*********k*********************************

Copyright (c) 2013-2014 released Microchip Technology Inc. All rights
reserved.

<See generated app.c file for copyright information.>

*************************k**k*********k**k****k**************************/

// DOM-IGNORE-END

// Ak kA kA Ak kA hkh Ak kA hhAhk kA hkhkhkh Ak hkhkhkhkrhkhkhkhkhAhk kA hhkhkhkrhkhkrhhkhkhkrhkhkrhkhhkhkkxkkxk*x

// KA AR A AR AR A AR A AR A AR AR A AR A AR AR A AR A AR A AR AR A AR A AR A AR AR A AR A A A AR A ARk hA Ak kK

// Section: Included Files

// KRRk A A A A AR A A A A A A AR A AR A A A A AR AR A AR A A A A A A AR A AN A A A A A A A A A A A A A AR A AR A Ak K,k

// KRR A A A A AR A A A A A A A A A AR A A A A AR AR A A AR A AR A A A AR A A A A A A A A A AR A A A A A A AR AR Ak kK

#include "app.h"

// KA AR A AR AR A AR A A A A AR AR A AR A AR AR A AR A AR A AR AR A AR A A A A A A AR A AR A A A AR A ARk hA Ak kK

// KRR KA AR AR A A A A A A A A A AR A A A A AR AR A AR A AR A A A AR A A A A A A A AR A AR A A A A AR A AR Ak kK

// Section: Global Data Definitions

// kA hkhkhkhhkrhkhkh kA hhkhh bk hhkdhhkhhkhkhhkhkhhkrhkhkhhkdrhhkrhkhkhhkrhhkrhhkhkrhkrhhkhkhkxhkxk*k

// Ak kA hk kA hkhkhkh Ak kA hhkhk kA hhkhhhAh kA hkhkrhkhkhkhkrhk kA hhkhkhkrhhkrhhkhkhkrhkhkrhkhkhkhkxkkxk*k

// KA AR A AR AR A AR A AR A AR AR A AR A AR AR A AR A AR A A A AR A AR A A A A A A A A A A kA A A A Ak Ak h Ak kK

/* Application Data

Summary:
Holds application data

Description:
This structure holds the application's data.

Remarks:
This structure should be initialized by the APP Initialize
function.

Application strings and buffers are be defined outside this
structure.

*/
APP DATA appData;

// KA AR A AR AR A A A A A A A AR AR A AR A AR A KR A AR A A KR A AR AR A AR A A A AR A AR A AR A AR AR AR Ak, K

// KA AR A AR AR A A AR A AR A AR AR A AR A AR AR A AR A A KA AR AR A AR A AR AR AR A AR A A A AR A AR Ak, K

// Section: Application Callback Functions
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// KRR A A A AR A A A A A A AR A AR A A A A A A AR A AR A A A A A A A KNI IR A A A A A A A A A A AR A A Ak x Ak K,k

// Ak hkhk kA hk kA hkhkh kA hhkhkh bk h kA hhkh kA hhkhkh kv hkhkhkhkrhhkrhkhkhhkrhkrhhkhkkrhhkrhhkhkhkxkkxk*k

/* TODO: Add any necessary callback functions.
*/

// B I i I b S I i b b b b b b I I b b i b b b I I b b S b b I I I b I I b b b I I b b b e b b b I I b b b I b b b b b b b i
// khkhkhkkhkhkhkhkhkhkhhhkhkhhkh bk bk dhhhk kb hkhhkhhkdhkhrhkhhkhkhkdhkhkhkdk bk hrhkhkhkdhhkhkhkrhk ok hhkhhxkx
// Section: Application Local Functions

// Ak hkkh kA hhkhkhkhhh kA hhkkhkhkhkhhk kA rhkkhkhkhkhhkkhhkhhkkhkhkhkhkhkhkhkhhkhkkhkhkhkhkhkhkrhhkkhkhkrhkhkhhxkk*x*x

// KA A KA AR AR A AR A AR A AR AR A AR A AR A KR A AR A A KR A AR AR A AR A AR A AR AR A AR AR A AR A AR hA Ak kK

/********************************************************************

Function:
void Set LED Status ( void )

Description:
Set LEDs to display the ADC average result.
*/

void Set LED Status(void)
{

int 1i;
appData.ledMask = 0;

/* Creates a mask for the LEDs, corresponding to the value read
* from the potentiometer */
appbData.potValue >>= 7; /* 10-bit value to 3-bit value */
for (i = 0; i <= appData.potValue; i++)
{
appData.ledMask |= 1<<(i);
}
/* Write the mask to the LEDs */
SYS PORTS Write( PORTS ID 0, PORT CHANNEL A,
(PORTS DATA MASK) appDbata.ledMask ) ;

// ok hkhkkhkhhkhkhkhkhkhkhkhhhk bk bk hhhkhhbhkhhk kb hhhrhkhhkhkhhhkhkdh bk hrkhkhkhkhkhkhkhkhhkhkrkhhkhkhxkx
// R R I i R I S S i S S I S I S b b b I S R I S S b I b b I S b b b S b e S b I 2h b b S b I 2b b S 2
// Section: Application Initialization and State Machine Functions

// Ak hkkhhkhkhkhkhkhkhhkhhkhAhhkhkhkhhhkhhkrhkhkhhhhkkhhkhhkhkhkhhhkkhkhkrhkhkhkhrhkhkhkhkrhkhkkhkhkrhkhhhhkhkkx

// KR AR A AR AR A AR A A A AR A AR A AR A AR AR A AR A A KR A AR AR A AR A AR A AR AR A AR A A A AR A AR A Ak, Kk

/********************************************************************

Function:
void APP Initialize ( void )

Remarks:
See prototype in app.h.
*/

void APP Initialize ( void )

{
/* Place the App state machine in its initial state. */
appData.state = APP _STATE INIT;

/* TODO: Initialize your application's state machine and other
* parameters.
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*/

/********************************************************************

Function:
void APP Tasks ( void )

Remarks:
See prototype in app.h.
*/

void APP Tasks ( void )
{

/* Check the application's current state. */
switch ( appData.state )
{
/* Application's initial state. */
case APP STATE INIT: -—— E&NH4.67
{
/* Enable ADC */
DRV _ADC Open () ;

appData.state = APP ADC WAIT;

break;

/* Display pot value on LEDs*/
case APP ADC DISPLAY: -—— ESNEATH
{

Set LED Status();

appbata.state = APP ADC WAIT;

break;

/* Wait for ADC */
case APP ADC WATT: <—— 55 N%4.8%
{

/* Wait for conversion*/

if (DRV_ADC SamplesAvailable())

{

int 1i;

//Read data
for (1=0;1<ADC_NUM SAMPLE PER AVERAGE;i++)
appData.potValue +=
PLIB ADC ResultGetByIndex (ADC ID 1, 1i);
appData.potValue = appData.potValue /
ADC NUM SAMPLE PER AVERAGE;

appData.state = APP ADC DISPLAY;

break;

/* The default state should never be executed. */
default:
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/* TODO: Handle error in application's state machine. */
break;

}

/********************************************************************

End of File
*/

46 MNABRFRS APP_STATE_INIT

MUESETFIART, BT AL THIARES . X FEBL T, ADCHETE A B RFEB T
flife. BJE, MAHBFIRESESANESR (APP_ADC WAIT) . MHEFREE app.h
g Lo

4.7 NABRFPRE APP_ADC_DISPLAY

fEAPP_ADC_WAIT case ) CHiH#EEIADCAE )5, #udid A “/Riss” #0me

#set LED Status () BniZflH. ZREM I (appData.ledMask) FRHEHE
f 75 ADCH (appData.potValue) E/RFILED L. XEEAFELE app.h & Lo

BRBGR A G, BHFEFIRARIAE [ APP ADC WATT, VAR T —UCREE.

4.8 NAREFIRES—APP_ADC_WAIT

¥I4aA (APP_STATE INIT) Ja, NFREFFHs 5550 il a3 (H AT 56 . 2 )a, #%
ADC &4 % & appData.potValue, PAfHEfEAPP ADC DISPLAY case /X H &/~
fELED I-. ADC NUM SAMPLE PER AVERAGEEapp.h & o
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5. i ADC# LED I B/~ 88E (MCC)

AR5 5 749 345 B AR (5] I 284 LA A2 3 1T A LED . (BAEA R, 8 FH s b s fr
MG B (RB2/AN2) fRft st sy (ADC) #i N, AT H I EoR
7ELED I,

RIBTLEFFNmE, w2l HMPLABILELE 2 (MPLAB Code Configurator, MCC)
A p. MCC & —#kdfifF, w7E MPLAB X IDE 3% Tools>Plugins ] Available Plugins
IR R e AR LR E 2 (5 2, 752 W MPLAB X IDE #: )

# FMCCHIZe A5 B L (MPLAB®ACHD L & 341 S #5F9)  (DS40001725B_CN)
TV i MPLAB X T i B 2% 1 7 -

http://www.microchip.com/mplab/mplab-code-configurator
ARG MCC ¥ B Wi bL R & B AR .

&l12: ADC T H &5 RGifHR

Projects | Files | Clazszes | Rezource Management [MCC] 2 [=]

Project Resources Generate

¥ System
Interrupt Module
Fin Module

System Module
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E13

ADC Tt H Z Gt fa] 5 B

StertPage | MPLAB X Store 3| MPLAB® Code Configurator 3

System Module

LD

{‘g} Easy Setup E Registers i Motifications : 1

¥ INTERNAL OSCILLATOR

FRC Oscillator (8 MHz)

8 Mz [ ]+

Clock Scurce

| -

v . FRC Postscaler

8000000 Hz | 11

- Postscaler

‘ » [_] PLLEnable

==
Peripheral Clock Divisor @-
[

8000000 Hz SYSCLK

4000000 Hz PBCLK

Clock Qutput Pin Configuration @ab'eD

I:' Use Secondary Oscillator (31k - 33 kHz)

|:| Enable Clock Switching
I:' Enable Fail-5afe Monitor

¥ ICD
Emulator Pin Placerr'ert‘ Communicate on PGEC2/PGED2 |i ~
¥ WDT

Enable GDT Disabled (SWDTEMN Bit Cnrtrola b I

‘ Clock Settings

Mode ‘ Watchdeg Timer is in Non-Window Mode I i ‘
Window Width Window Size is 25% -
Timer Postscaler | 1:1048576 -

Time-out Period  32.768s

DS50002509B_CN 26 1T
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K 14:

ADC i H ARG ER FF 3%

StartPage |4 MPLAB X Store 8|5 MPLAB® Code Configurator 2|  [4[2][=]

System Module 7 IE

@E} Easy Setu.p‘ = Registers ,;L, MNotifications : 1

¥ System Module

» Register: DEVCFGO Oc110FFO12

BWP ‘ Protection Disabled

CcP ‘ Protection Disabled

DEBUG ‘ Debugger is Disabled

ICESEL ‘Communicateon PGEC2/PGED2 | -
Disable |

' ITAGEN ‘ JTAG Disabled

© 2018 Microchip Technology Inc.
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& 15: ADC Ji H %5 ——ADC1

Device Resources ()

¥ Documents
FIC32MX470F512L Product Page
¥ Peripherals
v &g anc
SoaDpcl  Double click here to see
» —CVR

» ol Comparator
=12

Projects | Files |Classes | R’goume Management [MCC] 2 =]

Project Resources G}Arate

¥ System

Interrupt Module
Pin Module
System Module

¥ Peripherals

&g ADC1
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& 16: ADC T5i § ADC1 faj A ¥t B

StertPage 5|y MPLAB X Store 5|18 MPLAB® Code Configurator 22| ] main.c s ENES ]3]

ADC1

©
®

%g% Easy Setup E Registers .L, Motifications : 1

¥ Hardware Settings

Enable ADC
l Enable Auto Sampling

Enable Alternate input sample mode

ADC Clock
Sample A Negative Input | Vrefl | ol

1 T Conversion Iﬂﬂnﬁb—ﬁtema counter) | -
- - N\
Acquisition Time TAD Qutput Format Integer 16 bit | - |

TAD: S.0E-Ts Voltage Reference AVDDSAVSS .

l:l Enable ADC Interrupt

Conversion Clock Source

PBCLK | s

Sample B Negative Input

Conversion Clock

Selected Channels

Channel Custom Name Scan Enable

AN2 channel_ANZ2

RB2 = AN2 LS REAE B 17 P 13 58 R Bom

E17: ADCTji H ADC1 5| I %15

Pin Manager: Grid [MCC] & |

Package:|TQFDlCO|'| | Pin No: 17|33|53|59|su|s1|91|9z|2s|29|56|57 25|24|23|22|21|2D|26|27|32|
PortA Y PortB ¥
Module Function Direction |0 | 1|2 |3 (4|5 (6|7 |9 |10/14(15|0| 1|2 |3|4|5|6|7|38
ANx input B |m{a G INCBEC B
ADCLW VREF+ input B
VREF- input B
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K| 18:

ADC T H 38— 51 SR

Projects | Files | Classes | Resource Management [MCC] & [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module
System Module

¥ Peripherals

Bo ADC1

[x]

&19: ADC Tii H 5| s i B it B

StartPage 5|4 MPLAB X Store 5|00 MPLAB® Code Configurator  5¢| /& main.c 5 EREE
Pin Module (2 IS

£0% Easy Setup | [ Registers | /8 Notifications: 1
Selected Package : TQFPL00

Pin Name 4 | Module Function |Custom Name| Start High Analog Output WPU WPD oD 10C |
RAD Pin Module  |GPIO 10_RA0 ] ] ] L] none | -
RAL Pin Module  [GPIO 10_RAL ] ] L] L] .
RAZ Pin Module  |GPIO 10_RAZ ] ] L] L] .
RA3 Pin Module  [GPIO 10_RAS ] ] L] L]
RA4 Pin Module  |GPIO 10_RA4 ] ] L] L]
RAS Pin Module  [GPIO 10_RAS ] ] L] L] .
RAE Pin Module  |GPIO 10_RAG ] ] L] L] .
RAT Pin Module  [GPIO 10_RAT ] ] L] L]
RBZ ADC1 ANZ channel AN ] ] ] L] L]
RB6 1cD PGECZ ] ] ] ] L] L] .
R87 1cD PGED2 ] ] ] ] L] L] .

7E P 20 ik £ 5| IRAOQ:7 J5, X S8 5| s HBL/E B A& R
K17 2 ik $E 7 RB2,
K13 hik# 7 PGEC2/PGED2 (ERB6FIRB7) .

EHEOFERE, AT AR BOERE S| AL E
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& 20: ADC i H 5| %R

Output | Pin Manager: Grid [MCC] 2 |
Package:|TQFPlC{||'| | Pin No: 17|38|58|59|6l)|61|91|92|28|29|66|67 25|24|23|22|21|2D|26|2?|32|
Port AW PortB W
Module Function Direction | 0 | 1|2 |3 (4|5 (6|7 |9 |(10(14(15|0 | 1|2 |3 |4|5|6|7|38
ANx input m|h| @8 BB B BB
ADCLY VREF+ input B
VREF- input B
PGECxK input 0N | a8
Kow¥
PGEDx input B B a8
REFCLKT input B B
osC¥
REFCLKO output B i | B ha
_ GPIO input O O A O - O O - O - O A O - I B
Fin Module ¥ T
GPI0 oot (@A A A A A A A TETDEDEETESE S BB
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PR R % T B e RS S, 15 R “Project Resources”  (IiH % iE) & 1 LK
Generate (1) %4 (E12) . BEIEMCCA RIS R HAL I . Rk, EREAL
0 RGACE NSNS IO T B SO . Ak, BEANMEEE B Ok S

AL IE A B T A AR SO SR A MV AR A R . R AN R T PN S i, (H
SR P W AR SRR R AE A
AR PR NI eI 1A 22 T B R main . c. 15 A A AL B ST DAFR 2144 (ARG o i) Ag
i L HATAR] R B B
AR ADCIIEZEE, B2 (PIC32RFIBE TN ME17 5 “10 M BEEU
77 (DS61104D_CN) .

K 21:

i3 MCC A= st ) AXAS i ADC I3t H 4%

Projects # | Files |Clﬂsse3 | Resource Management [MCC] [=]
=@

BEI Header Files
Elﬁi MCC Generated Files

B adclh

[—}-ﬁ Important Files
i Makefile

L[ MyConfig.mc3
[a?_ﬁ Linker Files

E] meC,C
E] pin_manager.c

(g Libraries

(&} Loadables
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51 main.cBREHARKY
main.c BRSO A dmiE, WFAR. HodFEH< >HER, ROk, Sdm
Flmain () MR LAA A RN,
/‘k*
Generated Main Source File

<See generated main.c file for file information.>

*/

/*
(c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
this software and any derivatives exclusively with Microchip products.

<See generated main.c file for additional copyright information.>

*/
#include "mcc generated files/mcc.h"
unsigned int value = 0;

/* Creates a mask for the LEDs, corresponding
* to the value read from the potentiometer */
unsigned int Mask Value (unsigned int pot value) {
int 1i;
unsigned int mask value = 0;

pot value >>= 7; /* 10-bit value to 3-bit value */
for (i = 0; 1 <= pot value; i++)
{

mask value [= 1<<(1i);

return mask value;

/*
Main application
*/
int main(void) {
// initialize the device
SYSTEM Initialize();

while (1) {

// Wait for conversion -&—— {HESNES5.2F
// and then get result

while (!ADC1 IsConversionComplete());

value = ADCl ConversionResultGet ();

// Mark value - 1%372%%%53:?5
value = Mask Value (value);

// Write to Port Latch/LEDs -#—— &N EE5.4F
LATA = value;

N\

}

return -1;
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/**
End of File
*/
52 ADCHEH KR

MCC i id i & AD1CON1 H i1 %2>k JTJ5 ADC A I BlRAE R A LK A T 9 7 4
IREACRIEA R B 4. Ik, main () AORS R 55 244 i e 45 R T RIS

i adel . cBEH A U0 B 4L

bool ADC1l IsConversionComplete (void)
uintl6 t ADCl ConversionResultGet (void)

ARWEHABADCIIRERIE R, WS N (PIC32 R5IZ% Tlt) K17 & “10 8%
H¥ds (ADC) ” (DS61104D_CN) .

5.3 ADCHE#s B

HT R 8/LEDMH, HADCH#A R N100, KA value ) HH A5 Rl
B Mask_Value () f£fid, DMEKHE L3 — A A E/R7ELED L.

54 BN\ OSIFESFMLED
ADC # s hd 45 5o W7R 7R H AR LED F
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6. fELED F B/RIN7#{E (MPLAB HARMONY)

AR5 750 4 4 TR R (0 #5 44F LL St T A LED . BFEAORB R, Rid@id (JE 5 R
NAFBESE, JFaRoRRsig{Emsh (LED2) 2K (LEDO) .

RILETE Fsh4m 5, 1M MPLAB Harmony 4= . A 3¢ i T % 14 3 MPLAB
Harmony 4 ik & 44: #E 2 1 MPLAB Harmony it & #% (MHC) MPLAB X IDE #1115
B, i3 WE4T “fH ADCFELED LB/ RE/83E (MPLAB Harmony) ” .

A FKAEMPLAB X IDEH 1] # MPLAB HarmonyTii H (15 5., {52 IL#4.175 “ZEMPLAB
X IDE F4JZ—/ MPLAB Harmony i H ” . A/RHIHK I H &N “Example6” .

ATRBIHET DU AT T INAE RSN 7 (LA Windows #:4E R G i) -
C:\microchip\harmony\vl 10\apps\examples\peripheral\flash\flash modify
6.1 FicE MPLAB HarmonyJiH

WP H % &, MPLAB Harmony Fit & 28 (MHC) 7 FF i1 $2 435 4 ik 45 B
PLE (2,98 Y R B SUAR SRR B o FEAGH, AN I b 18 B 3 A7 o] B 4o

e & NIRRT (22 B ) AR SZ 4 (BSP) (I 23 Ats) &
K 22. HARMONY tE 48 fic B — INFREEF

Start Page E| -ﬁ' MPLAB X Store E| MPLAB® Harmony Configurator® 2
PP | b |0 | %

Options™ |Clock Diagram X | Fin Diagram X | Fin Settings X

}-Drivers
1-ADC
é—--Camera
i CMP
é—--CODEC
+ -ENCX241600
- ENC28160
%--Flash
. & [¥] Use FLASH Driver?
| Briver T e

""" Urver Impiementaaon (o 1L

. Prankice Crmdeallace
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& 23: NAETH RIRECE

StartPage 22|99 MPLAB X Store El MPLAB® Harmony Configurator® 2
B PP | oo |25 | T

Options® |Cluck Diagram X | Fin Diagram | Fin Settings %

MPLAB Harmony & Application Configuration

---.ﬁ.pplicaﬁl:un Configuration

--Harmony Framewark Configuration

[%I--BSP Configuration

. [#] Use BSP?

é}--SEIE:t BSP To Use For PIC3ZMX4/0F512L Device
----- [] PIC32 Bluetooth Audio Development Kit

PIC3I2MX470F512L PIM w\Explorer 16

. [F] PIC32MX USB Starter Kit 3

[+-Third Party Libraries

[+-Device & Project Configuration
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6.2 AR IERIgREE N TR S

PR E R % B % E 5 MHC J5, 1% % MPLAB Harmony Configurator i 17 < | (1)
Generate Code 14l .

: L= |
iagram Generate Code

TRAFHC B X BB 4.3 “AE RS M gm i R FE R ST A il H AR

MPLAB Harmony A= i 1 AR RS & B B A0 1), Wi l&24 Fros. M T SO (app.h M

app.c) e ARG IS

HxRMEANEREZHEE, 531 (PIC32R 52 % F M) ME53= “NAHAE”
(DS60001121G_CN) .

& 24: 8t MHC 4 g B AR B IN 7730 B

Projects & | Files |Clﬁsse5 | [=]
SR = NExamples

I_‘—}[aﬂ Header Files

E'[ai app

EI app.h

ﬁ system_config
bsp

ﬁ framework
[Er--ﬁ‘ Important Files

Qﬁ Linker Files

I:—}-[ai Source Files

E'Ei app
T appac

i E] main.
ﬁ system_config
ﬁ bsp

E framework
E-[ez Libraries

il E wofvofi ] fbinfframework peripheral PIC32MX470F 5120 _peripherals.a
(&t Loadables
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6.3 app.hBHERIRE

app . BRI Ot i, W R os. FRTERMI < >4Ek, FoRClilkk. Sasmm
RIG LA RIR .

/********************************************************************

MPLAB Harmony Application Header File

<See generated app.h file for file information.>

************************************k********************************/

//DOM-IGNORE-BEGIN
/********************************************************************
Copyright (c) 2013-2014 released Microchip Technology Inc. All rights
reserved.

<See generated app.h file for copyright information.>

******k*************************************************************/

//DOM-IGNORE-END

#ifndef APP H
#define APP H

#define USERLED SUCCESS LED 2 //D5 on Explorer 16/32
#define USERLED ERROR LED 0 //D3 on Explorer 16/32

// B S b i I I I b b I b b b I I b I i b b b b b b S b b b I I b I I b b b I I b b b e b b b I I b b b I b b b b b b b i
// KAk kA Ak hk kA Ak hkhk Ak hk ok Ak ko hk kA ko ko hk Ak ko hk kA h ko ko hkhkhk ko kA drhkhkhkdhkhhkhkrhhkkhkhkrhkhkkhkkxhhk k%
// Section: Included Files

// KAk hkhk kA hhhkhkhhh kA hkhhkhkhkhhk kA hhkhkhkhkhhkkhkhkhhkhkhkhkhkhhkhkhhkhkhkhkhkhhkhkrhhkkhkhkrhkhkhhxkk*xx*x

// KA AR A AR AR A AR A A A A AR AR A AR A AR A A A AR A AR A AR AR A AR A AR AR A AR A AR A A A A AR ARk h Ak kK

#include <stdint.h>

#include <stdbool.h>

#include <stddef.h>

#include <stdlib.h>

#include "system config.h"
#include "system definitions.h"

// DOM-IGNORE-BEGIN
#ifdef  cplusplus // Provide C++ Compatibility

extern "C" {

#endif
// DOM-IGNORE-END

// R R R R I I i I I I S i S b I b I I I S b e b b b R I b S b e S b I b R S b i S b I 2b b S 2
// RS S S S R RS I e I I I I b I I b I b I e b b I i b i b b b b b
// Section: Type Definitions

// R B I R I I e I b I I b I b b b e I b b e b b I I b I I I b b I I b b b b b b I I b b b b b b b b b b i

// R R i B I R R I R R R R R R b R R b b b b b b 2

#define APP DATABUFF SIZE (sizeof (databuff) /
sizeof (uint32 t))

/* Row size for device is 2Kbytes */
#define APP DEVICE ROW SIZE DIVIDED BY 4
(DRV_FLASH ROW SIZE/4)
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/* Page size for device is 16Kbytes */
#define APP DEVICE PAGE SIZE DIVIDED BY 4
(DRV_FLASH PAGE SIZE/4)

#define APP_PROGRAM FLASH BASE ADDRESS VALUE (unsigned int)
0x9D008000

#define APP_PROGRAM FLASH BASE ADDRESS (unsigned int *)
APP_PROGRAM FLASH BASE ADDRESS VALUE

// R R I S b S b S b S S S SE i I b S b b S b b Sh  Sh b b 2b b b 2h S Sb b Sb db b Sh b S Sh S db e Sb b b 2h b S Ib S 3b 2 2b dh S 2 3

/* Application states

Summary:
Application states enumeration

Description:
This enumeration defines the valid application states. These
states
determine the behavior of the application at various times.

*/

typedef enum

{
/* Application's state machine's initial state. */
APP_STATE INIT=0,
APP_STATE NVM FILL DATABUF AND ERASE STATE,
APP STATE NVM ERASE COMPLETION CHECK,
APP STATE NVM WRITE START,
APP STATE NVM WRITE COMPLETION CHECK AND VERIFY CHECK,
APP STATE NVM ERROR STATE,
APP_STATE NVM SUCCESS STATE,

} APP_STATES;

// KA A AR AR AR A A A A A A A AR AR A AR A AR A R A AR A AR A A A AR A AR A A A AR A A Ak Ak A A A A Ak Ak h Ak kK

/* Application Data

Summary:
Holds application data

Description:
This structure holds the application's data.

Remarks:
Application strings and buffers are be defined outside this
structure.

*/

typedef struct

{
/* The application's current state */
APP STATES state;
DRV _HANDLE flashHandle;

} APP DATA;

// Ak hkhk kA hk kA hkhkh kA hhkhhhkh kA hhkhkhhkhhkhkhhkrhkhkhkhkdrhhkrhkhkhkhkrhkrhhkhkkrhhkrhhkhkxhkxk*k

// R R I S b I b S b b S S S SE S S Sb b b S b b Sh S b I 2b b b 2h S b e Sb b b Sh b S Sb S db e Sb b I 2b b S Sb S 2b S Sb db b 2 Y
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// Section: Application Callback Routines

// Ak hkhk kA hk kA hkhkh kA hhkhkh bk h kA hhkh kA hhkhkh kv hkhkhkhkrhhkrhkhkhhkrhkrhhkhkkrhhkrhhkhkhkxkkxk*k

// Ak hkhkhkhkhhkkhkhkhhkhhkhAhhkhkhkhkhhkhkhkhrhkhkhhhhkhhkhhkhkhkhkhkhkhhkrhkkhkhkhrhkhkkhkhkrhhkkhkhkrhkhhhxkk*k*x
/* These routines are called by drivers when certain events occur.

*/

// KRR AR A AR A A A A A A AR A AR A A A A A A AR A A A A A A A A A AN A A A A AR A A A AR A A A AR AR AR x Ak Kk

// kA hkhk kA hk kA hkhkh kA hhkhhhkhhkdhhkh kA hhkhkhhkrhkhkhhkdrhhkrhkhkhhkrhkrhhkhkrhhkrhhkhkhkxhkxk*k

// Section: Application Initialization and State Machine Functions
// Ak hkkh kA hhkhkhkhhh kA hhkkhkhkhkhhk kA rhkkhkhkhkhhkkhhkhhkkhkhkhkhkhkhkhkhhkhkkhkhkhkhkhkhkrhhkkhkhkrhkhkhhxkk*x*x

// KA A KA AR AR A AR A AR A AR AR A AR A AR A KR A AR A A KR A AR AR A AR A AR A AR AR A AR AR A AR A AR hA Ak kK

/********************k******k********k*k*****************‘k***************

Function:
void APP_Initialize ( void )

Summary:
MPLAB Harmony application initialization routine.

<See generated app.h file for app init information.>
*/
void APP Initialize ( void );

/********************************************************************

Function:
void APP Tasks ( void )

Summary:
MPLAB Harmony Demo application tasks function

<See generated app.h file for app tasks information.>
*/

void APP Tasks( void );

#endif /* APP H */

//DOM-IGNORE-BEGIN
#ifdef  cplusplus
}

#endif
//DOM-IGNORE-END

/***k***********k******************************************************

End of File
*/
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6.4 app.cEH/EKAE

app . BRI Ot i, W R. FERM < >4, FoRCllkk. Sasinm
(AR T EARGR T o7
A EEATARAS, R AL DU P AT s o SR AT A B 5 3R] AR SO A BY D) AH N2 9 28 9
b 210G 4 2 7

/********************************************************************

MPLAB Harmony Application Source File

<See generated app.c file for file information.>

*******************************************************************/

// DOM-IGNORE-BEGIN

/********************************************************************

Copyright (c) 2013-2014 released Microchip Technology Inc. All rights
reserved.

<See generated app.c file for copyright information.>

*******************************************************************/

// DOM-IGNORE-END

// KA AR A AR AR A AR A AR A AR AR A AR A AR AR A AR A A KA AR AR A AR A AR AR A AR A A A A AR AR A ARk hA Ak kK

// KA AR A AR AR A AR A AR A AR AR A AR A A KA AR A AR A AR A AR AR A AR A AR A AR AR A AR A A A AR A ARk h Ak kK

// Section: Included Files

// KRR A A A A AR A A A A A A A A A AR A A A A AR AR A AR A AR A A A AR A A A A A A A A A AR A A A A A A AR A AR A Ak, K

// Ak hkhkhkhkhkrhkhkh kA hhkhh bk hhkrhhkhhkhkhhkhkh kv hkhkhhkdrhhkrhhkhhkrhkrhhkhkkrhhkrhkhkhkxhkxk*k

#include "app.h"

// KA A AR A A AR A A A A A A AR A AR A A A A AR AR A AR A AR A A A AR A A A A AR A A A A A A A A A A A AR A AR Ak kK
// KA AR A AR AR A A A A A A A A A AR A A A A AR A KR A AR A A KA A A A AR A AN A A A AR A AR A A AN A AR A AR Ak KK
// Section: Global Data Definitions

// B R e R R e R e R e I R I R S R I R I e S R I S I R S R I R R R i I R S e

// Ak kA hk kA hkhkhkhk Ak kA hhkhk kA hhk Ak h Ak kA hkhkrhk kA hkhkdAhk kA hhkhkhkrhkkrkhhkhkkrhkhkrhkhkhkkhkxkkxk*k

/*****************************************************

* Initialize the application data structure. All
* application related variables are stored in this

* data structure.
*****************************************************/

/* Array in the KSEGl RAM to store the data */
uint32 t databuff[APP_DEVICE ROW SIZE DIVIDED BY 4]
__attribute ((coherent, aligned(16)));

// kA hkhk Ak kA hkhkhkhk Ak kA hhkhk kA hhk bk hkhkhkhkhkhhkrhkhkhkhkrhkhkrhhkhhkrhkrhhkhkkrhkhkrhkhkhkhkxkkxk*k

/* Application Data

Summary:
Holds application data

Description:
This structure holds the application's data.

Remarks:
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This structure should be initialized by the APP Initialize
function.

Application strings and buffers are be defined outside this
structure.

*/
APP DATA appData;

// R R I S b S b S b S S S SE S b Sh R b S b b Sh S b b 2b b b 2 S b Sb 2b I Sh b S Sh S db e Sb b I 2b b S Sb S 2b I 2b dh b 2 3
// KA A KA AR AR A AR A AR A AR AR A AR A AR A KR A AR A A KR A AR AR A AR A AR A AR AR A AR AR A AR A AR hA Ak kK
// Section: Application Callback Functions

// KRRk A A A A AR A A A A A A AR A AR A A A A A A AR A A A A A KA A A A AR A AN A A A A A A A AR A A A AR A A A A A Ak,

// Ak hkhk kA hk kA hkhkh kA hhkhkh bk hhkdhhkhhhkhhkhkh kv hkhkhkhkrhhkrhkhkhhkrhkrhhkhkrhkrhhkhkhkxhkxk*k

/* TODO: Add any necessary callback functions.
*/

// R S i I I I I i b b e b b b I I b b i b b b I b b I b b b I I b I I b b b I I b b b e b b b I I b b b I b b b b b b i
// khkhkhkkhkhhkhkhkhkhhkhkhhhkhhkhkhhkhhhk bk hkh bk hhkhkhk bk hkhhhkhkdhk kb hkrhkhkhkhkhkhkhkrhk ok hkkhkhkxkx
// Section: Application Local Functions

// Ak hkhk kA hkhkhkhkhhkhhkhAhhkhkhkhkhhkhkhkhhkkhkhkhkhhkkhkhkhhkhkhkhkhkhhkhkhhkhkhkhdhkhhkhkhrhhkkhkhkrhkhkhhhkk*x*x

// KA AR A AR AR A A A A AR A AR AR A AR A AR AR A AR A AR A AR AR A AR A AR A AR AR A AR AR A AR A ARk hA Ak kK

/* TODO: Add any necessary local functions.

*/

// Kk hkhhkhkhkkhkhkhkhhkhhkhAhhkhkhkhhhkhkhhrhkhkhhhhkhhkhhkhkhkhrhhkkhkhkrhkhkhkhrhhkhkhkhrhhkkhkhkrhkhhhxkhkkx
// khkkhkkhkkhkhkhkkhkhkhkhhkkhkhkhAhhkkhkhkhkhhkhkhkhhkhkhAhkhhkhhkhhkhkhkhhhkkhkhkhrhkhkkhkhohkhkhhkhrhhkkhkhkhrhkkhkhhrhkhkhkx
// Section: Application Initialization and State Machine Functions

// ok hkhkkhkhhkhkhkhkhhkhkhhhkhhkhk bk hkhhkh bk bk kb hhhhkhhkhkhk kb hk bk khkhkhkhkhkhkhkrhkhkrkhhkhhxkx

// Ak kA hk kA hkhkhkhk Ak kA hhkhk kA hhkhhk Ak kA hkhkrhkhkhkhk Ak kA hhkhkhkrhkrhhkhkhkrhkkhkrhhhkkhkxkkxk*x

/***************k**k***********k****************************************

Function:
void APP_Initialize ( void )

Remarks:
See prototype in app.h.
*/

void APP_Initialize ( void )
{

/* Place the App state machine in its initial state. */
appData.state = APP_STATE INIT;

/* TODO: Initialize your application's state machine and other
* parameters.

*/

/***k***********k******************************************************

Function:
void APP Tasks ( void )

Remarks:
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See prototype in app.h.
*/

void APP Tasks ( void )
{
unsigned int x;
/* Check the application's current state. */
switch ( appData.state )
{
/* Bpplication's initial state. */ -&—— HSNE6.5T
case APP_STATE INIT:
appData.flashHandle = DRV_FLASH Open (DRV_FLASH INDEX O,
intent) ;
appData.state = APP STATE NVM FILL DATABUF AND ERASE STATE;
break;

/* Fill data buffer, clear LEDs, -#—— i5Z0L56.67
* and begin erase page */
case APP STATE NVM FILL DATABUF AND ERASE STATE:
for (x = 0; x < APP_DATABUFF SIZE; x++)
{
databuff([x] = x;
}
BSP LEDOff (USERLED_ SUCCESS) ;
BSP LEDOff (USERLED ERROR) ;

/* Erase the page which consist of the row to be written */
DRV _FLASH ErasePage (appData.flashHandle,

APP PROGRAM FLASH BASE ADDRESS VALUE) ;
appData.state = APP STATE NVM ERASE COMPLETION CHECK;
break;

/* Check for erase complete */ -4—— 1%572)’_&,%6.7_"5
case APP STATE NVM ERASE COMPLETION CHECK:
if (!DRV_FLASH IsBusy (appData.flashHandle))
{
appData.state = APP STATE NVM WRITE START;

}

break;

/* Write row of Flash */ -4—— i5ZL56.87
case APP_STATE NVM WRITE START:

/* Erase Success */
/* Write a row of data to PROGRAM FLASH BASE ADDRESS,
* using databuff array as the source */
DRV _FLASH WriteRow (appData.flashHandle,
APP PROGRAM FLASH BASE ADDRESS VALUE, databuff);
appData.state =
APP STATE NVM WRITE COMPLETION CHECK AND VERIFY CHECK;
break;

/* Check for write complete -#—— {FZNE6.97
* and verify write operation */
case APP STATE NVM WRITE COMPLETION CHECK AND VERIFY CHECK:
if (!DRV_FLASH IsBusy (appData.flashHandle))

{
/* Verify that data written to flash memory is valid

* (databuff array read from ksegl) */
if (!memcmp (databuff,
(void *)KVAO TO KVAL (APP_PROGRAM FLASH BASE ADDRESS),
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sizeof (databuff)))
{

appData.state = APP STATE NVM SUCCESS STATE;
}

else

{
appbata.state = APP STATE NVM ERROR STATE;
}
}

break;

/* Write Failure */ -—— {HEZNFE6.107
case APP STATE NVM ERROR STATE:
/*stay here, nvm had a failure*/
BSP LEDOn (USERLED ERROR) ;
BSPiLEDOff(USERLEDiSUCCESS);
break;

/* TWrite Success */ -&—— {HFHENE6.11T
case APP STATE NVM SUCCESS STATE:

BSP_ LEDOn (USERLEDisUCCESS) ;

BSPiLEDOff (USERLEDiERROR) ;

break;

/********************************************************************

End of File
*/

6.5 MNHEFRE—AHERE

MUESEATFUART, R THIMIRA (APP_STATE INIT) . fEXMIEHL T, W
HFIRENFE PR HATHIIEN, IR AT — MRS

(APP_STATE NVM FILL DATABUF AND ERASE STATE) . MHFEFIRATEapp.h

HE e

6.6 MNHABEFRE—HEHREMN XAEERT

M e R, B HAT 5 NHER R . 20, MBS XK 5NN IIE (3
FEMIXTE “RREURE L7 HE S o HE, THRIEE IR LED FRARES
(REEEAEapp. . h PIRE) o AR5, TFIREERING (NVM) BT, fa, BHIREFFIRES
W BSOS TTHERR 52 (APP_STATE NVM_ERASE COMPLETION CHECK)

6.7 MNAEFRE— RERTR

R SEAAE BT — MRS T IR I TR e S8R, AR P RS B S SO T 4k
HANWA (NVM)  (APP STATE NVM WRITE START) .

6.8 NABEFRE—FBANFT

BUETHIE NN ORI — AT BdRZe b X TP MER S NI4T . e, BATRER
R SO R BN SE RO RAE S R
(APP_STATE NVM _WRITE COMPLETION CHECK AND VERIFY CHECK)
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6.9 NHABFRE T NSERIFRIE
IRSERHERT — DRSS FHERATE NS K. 5ERE, RIRIEEEE X i E SIS
NERAE . AR N, WS R IRAS K BN APP_STATE NVM_SUCCESS_STATE.
IR NIRRT N R PR K BE U APP_STATE _NVM_ERROR_STATE.

6.10 NMABRFRE—ERRE

R INAEE RN, N RRES . BRI EMLED 3 (D3) ¥ iz, RanRAET
B

6.1 NMAEFRE FRIRZS

INAE DI EBRIF B NG, BIE NSRS . BRI ELED 5 (D5) ¥ s, RoRM
FHREF BRIIIAT -
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7. fELED L B/RNFE{E (MCC)

AR5 750 5 48 F A R] (0 #5 44F LL St T A LED . BFEARB R, K@it (JE 5 R
NAFEESE, JFaRoRRsig{Emsh (LED2) 2K (LEDO) .

i FHMPLABARISAC B &% (MCC) SRAE /RS . B8R 1 f# Woifl 423 MCC AR ELMCC
HrfemEnfER, SN0, $5% “[#H ADCHLED LB/ A3 E (MCC) ” .

ARl R B MCC B B 1 BL R - B«
& 25: NI H BER —— RGARR

Projects | Files |Cl.asses | Resource Management [MCC] 2 =]

Project Resources Generate

¥ Gystem
Interrupt Module
Pin Module

System Module
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] 26: NFFTR B 2GR e 5 B

StartPage = | ‘%9 MPLAB X Store 52 |[ER MPLAB® Code Configurator 52

System Module

L=

@E} Easy Setup E Registers .i. MNotifications : 1

¥ INTERNAL OSCILLATOR

FRC Qscillator (8 MHz)

8 MHz |:| Hz

| -

v . FRC Postscaler

8000000 Hz | 11 - Postscaler

| » [_] PLLEnable

v
Peripheral Clock Divisor @]-
[

8000000 Hz SYSCLK

4000000 Hz PBCLK

Clock Source

Clock Output Pin Configuration @ab'eD

I:‘ Use Secondary Oscillator {31k - 33 kHz)

I:‘ Enable Clack Switching
I:‘ Enable Fail-Safe Monitor

¥ ICD
Emulator Pin PIacerrer't‘ Communicate on PGECZ2/PGED2 |i il
¥ WDT

Enable GDT Disabled (SWDTEM Bit Controls) H b ‘

| Clock Settings

Made | Watchdeg Timer is in Non-Window Mode I - I

Window Width Nindow Size is 25% -

Timer Postscaler | 1:1048576 -

Time-out Period 32,7685

© 2018 Microchip Technology Inc.
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& 27: NPT B R GER T 88

StartPage |4 MPLAB X Store 8|5 MPLAB® Code Configurator 2|  [4[2][=]
System Module 7 IE

@E} Easy Setu.p‘ = Registers ,;L, MNotifications : 1

¥ System Module

» Register: DEVCFGO Oc110FFO12

BWP ‘ Protection Disabled

CcP ‘ Protection Disabled

DEBUG ‘ Debugger is Disabled

ICESEL ‘ Communicate on PGEC2/PGED2

' ITAGEN

PWP ‘ Disable

JTAG Disabled
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K28 NFF T H HIR——NVM

Device Resources @ -

Ext_Interrupt

P 120

b IO

v SN

EInvM  Double click here to see

b o OC

v [Brrcc

PSSP

» IfE_“_- Tirmer

w

Projects | Files |Clnasses | Egsource Management [MCC] =]

Project Resources Ggfierate

¥ System
Interrupt Module
Pin Module
System Module

¥ Peripherals

(MM !
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& 29: AT H NVM 577 5%

StartPage |4 MPLAB X Store 52| L0 MPLAB® Code Configurator | |mainc | [[2][=][=2

NVM @&
@E} Easy Setupi E Registers !,;!_, MNotifications : 0
¥ NVM

Interrupt Enables

I:' Flash Central Event

+ Register: NVMADDR | 5

MNVMADDR | OO

v Register: NVMCON | no0003

]

LVDERR ‘ disabled

LVDSTAT ‘ disabled

WR ‘ disabled

G\JREN

WRERR ‘ disabled

enabled

GVMOP ‘ Row program cperation | hd

» Register: NVMDATA 4.5

MNVMDATA | 0w

v Register: NVMEKEY = g,

NVMKEY | OxO

» Register: NVMSRCADDR | 5

MVMSRCADDR | OxD
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& 30: NI H B8 —— 51 BBk

Projects | Files |Classes Resource Management [MCC] 2 =]

Project Resources Generate

¥ System
Interrupt Module
Pin Module
System Module

¥ Peripherals

=T

& 31: WD B 110 5| R E

@

StartPage 5| MPLABX Store 32| I MPLAB® Code Configurator 3¢ B3I

Pin Module [? JIRE]

@g@ Easy Setup E Registers .L. Motifications : 0
Selected Package : TQFP100

Pin Name 4 | Module Function |Custom Name| Start High Analog Output WPU WPD oD 10C |
RAD Fin Module | GPIO 10_RAD ] ] L] L] none | -
RA2 Pin Module  |GPID 10.RAZ ] ] ] L] .
RB6 1cD PGECZ ] ] ] ] L] L] .
R87 1cD PGED2 ] ] ] ] L] L] .

R 32 ik F 5| HIRAOMIRA2 f5, IXLes| Js B IL7E L H .
K26 ik T PGEC2/PGED2 (EIRB6#IRB7) .
Ew A ERE, WONEA S HEE SRR 5 i E .

& 32: R B 110 5| % IR

QOutput - MPLAB® Code Configurator | Pin Manager: Grid [MCC] |

Package:|TQFpm:||v| | Pin No: 17|38|58|59|60|61|91|92|28|29|66|67 25|24|23|22|21|20|26|27|32|
PortA'Y PortB ¥
Module Function Direction | 0 1|2 |3 |4|5|6|7|9(10[14/25(0|1|2|3|4|5|6|7]|38
PGECx input 'h 'h
ocv
PGEDx input B B a
REFCLKI input B i
0sCY
REFCLKO output i i T h
N input g%hhhhhhhh%hhhh%hhhhh
6P10 e O O NI NI I
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A TFEIME MPLAB® XC32 FH F#5 5

PR BRI B =AY S, iE iy “Project Resources” & I L[] Generate 2411
(E12) o #id MCCAE AR R H ). Rk, F RS, RGRIEFISMEAR
T T B SO . ek, BEANIMEEE OISk S .

3 T A RS W B R SRR ST AR (R R R AR R R AN S A A R, (H
S R W BRSSO B R AT

[ FEFE R I RE I G 4 T B i main . oo A LRI SO AR BN AR b v ik
i 22 AT AT bR A B
AREANEMELZEE, i3 0 (PIC32R 512 % TM) MEsH “INAmRE”
(DS60001121G_CN) .
B33: @it MCCA: BRI ARAG I [N 22 30 E A%

=

Projects ¥ | Files |Clﬁsse5 |
E'@

BE Header Files
El[a:j MCC Generated Files
E] interrupt_manager.h

E] rvm.h
E] pin_manager.h
=g ﬁ Important Files

-] Makefile
L [F MyConfig.mc3
[a:j Linker Files
=} E Source Files

.....
.....
.....

EI ﬁ MCEC Generated Files
E] interrupt_rmanager.c

E] nm.
E] pin_manager.c

[z Libraries

E; Loadables

.....
.....
.....
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71 main.cBREHRG
main.c BRSO A dmiE, WFAR. HodFEH< >HER, ROk, Sdm
FEARETYCAR RTINS
/**
Generated Main Source File

<See generated main.c for file information.>

*/

/*
(c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
this software and any derivatives exclusively with Microchip products.

<See generated main.c for additional copyright information.>

*/
#include "mcc generated files/mcc.h"

// Program Flash Physical Addresses: 0x1D00 0000 - 0x1DO7 FFFF

// Program Flash Virtual Addresses: KSEGO: 0x9D00 0000 - 0x9D07 FFFF
// KSEGl: 0xBDOO_ 0000 - 0xBDO7_ FFFF
#define NVM PROGRAM PAGE 0xbd008000

unsigned int databuff[128];

/*
Main application
*/

int main (void) {
unsigned int x;

// initialize the device
SYSTEM Initialize();

// Fill databuff with some data
for(x =0; x < sizeof (databuff); x++)
databuff[x] = x;

// Erase second page of Program Flash -—— {ESNE7.2T
NVM ErasePage ((void *)NVM PROGRAM PAGE) ;

// Write 128 words starting at -—— i%zjﬂ%73:ﬁ
// Row Address NVM PROGRAM PAGE
NVM WriteRow ((void *)NVM PROGRAM PAGE, (void*)databuff);

// Verify data matches -S—— {ESNET.4T

if (memcmp (databuff, (void *)NVM PROGRAM PAGE, sizeof (databuff)))
{

// If not turn led0 on to indicate an error

IO RAQO_SetHigh();

else {
// If true turn led2 on to indicate success
TO RA2 SetHigh();
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while (1) {
// End of program

}

return -1;

}

/**

End of File

*/

7.2 BBRRNAER

PRI A7 R ] DA B ) B /N 43 72 T o

£ nvm. ¢ XA FINVM_ErasePage() %
7.3 EANFT

B2 X N B SN NMNAFAT
7F nvm. c F K FINVM_WriteRow() 5 %7 .

74  BIEBREIEEIEERELED -

BB S5EHR g XN AT IR IR N AEAILE, LED DO/D3¥ iz, R
AR . IR AZSILAS, Explorer 16/32 Hig R F I LED D2/D54 mise, Ronfl.
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A. 7£ MPLAB X IDE HiZ4T/4H5

X1, 2813, #% LR IRAIE— A0 -

1. JA3IMPLAB X IDE.

2. MIDEHEZhH T H 5 (File>New Project) .
3. MR RfRROIE— /M -

a) Choose Project GE#ETH) : 4 “Microchip Embedded” (Microchip
AR , AR5 “Standalone Project” (i IiH)

b) Select Device GEFFRM) : EBFERHIFAF.

c) Select Header (i&#HIARAL) : L.

d) Select Tool GEFTR) : HidJF45 (Serial Number, SN) SNxxxxxxi%
B ER TR, RS TR AT ARERSN, iEH AR LA D IE
w2, BREMEE, HES IR T H .

e) Select Plugin Board GEHEHER) : T.

f) Select Compiler (i£#4%i%a3%) : WIHXC3I2 (RHKAE) [bin TIHFfr
H]o WEHRXCI2 FRERImIFEE, HH R iIEH C IR %3 H MPLAB X IDE
[ E| e . Uk $E Tools>Options (T.E>iE5) , .17 Build Tools (%1% T
H) %7k LA Embedded (CLzc3E T H) #4l, mIREHIRmIERE. R0
{5, 52 I.MPLAB XC32 fIMPLAB X IDE 3%,

g) Select Project Name and Folder GE&#IH ZRCHI) « NI H M4 .

4. 1k Projects (IUH) % ITH I H AR, EHE: New>Empty File Giri>=3

HC) o BERTE R 5 New Empty File CGHrias (ACE) KHEHE .

5. £ “File name” (%) FHINAK.

6. HdiFinish (5EHD .

7. WA R R BT IR B AR RS R W B A dm iR E L1, SR 5 %% File>Save
CHE>1RAF)

TRl 4 FoR 16, %S 4.1 “ZEMPLAB X IDE F16/8—4> MPLAB Harmony 75

B” e PRAE—-ATE. )5, %EMEEEMHC, A4 AR I g 45 B

FEFP .
XEFoRGISANT, L T 10 PR B 3REAT A . ARSI IHE BLEMCC, AR Ry
I G I FE S o

feJa, ik Debug Run CGRRIZAT) SR BEACAD . K ARS8 80 a5 1 o LA K& AT AR
. fELED EMERE T4t . i Halt %) S5H4T.

& 34: TAER
5 o

|Del::|ug Main F'ru:uject| |Fir1i5h Debugger Session (Shift+ F5]|
WRB1T iz
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B. FREUKAFORE{E
ST AR MPLAB XC321 H, 34 PIC32 PIM ] Explorer 16/32 ¥ H1 9V #h &kt
VAL, JRE SR (ICSP™) JE{5. #H MPLAB X IDE #H7H % .
B.1 3KEUMPLAB X IDEfIMPLAB XC32 C%mi¥3%
A7 ML M EFR 2 MPLAB X IDE v3.55 J% DL F A :

http://www.microchip.com/mplabx

A MEA R R HEFR 2] MPLAB XC32 CZRiFesv1.42 K UL _ERRA
http://www.microchip.com/mplabxc

B.2 3#KE{MPLAB Harmony FIfi¢ B 23 4#

Al LR 7 207 MPLAB X IDE 7148 2] MPLAB Harmony it & %% v1.0.10.xx & 5 i il AR :
Tools>Plugins "' ] Available Plugins & i .
Al LA B3R 1 MPLAB Harmony v1.10 2 DL _E A :

http://www.microchip.com/mplab/mplab-harmony

B.3 KB MPLABHSEEZ (MCC)

Al A EL R PR I MCC v3.26 & D I Fit A :
http://www.microchip.com/mplab/mplab-code-configurator

B.4 3KE(PIC® MCU BRI (PIM)

Microchip Technology M F#24L [ 7~ 451 4145 FH (1) PIC MCU PIM:
PIC32MX470F512L: http://www.microchip.com/MA320002-2
B.5 #KEXI i E Explorer 16/324%

Explorer 16/32 Jf AR« JR BE AN SRS W] 78 DL T Wt F 4R 2]
http://www.microchip.com/dm240001-2

TRINE T BRI G E
F1-1:  THKBEL /TP RiEHE
Bk 1 P55 bt ek /1 FFoE P

JP2 ks J37 W T
J19 Wi FF J38 Wi
J22 Wi T J39 LTSIN
J23 LN J41 Wr T
J25 iy J42 Wi
J26 Zikay J43 BRI\
J27 b J44 LN
J28 b T J45 LN
J29 Wi T J50 LilAy
J33 Wi
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B.6  3KE!Microchip Ak TE

AR N JT R TR b 4 20477 B A K 2 -
http://www.microchip.com/development-tools
B.7 IREUREIRIY

AR Pk AR SR A iR ARG s 451«
http://www.microchip.com/mplabxc

Documentation (k%) &K K. ¥ MPLAB Harmony /~il & T DL R e Jerf
C:\microchip\harmony\vl 10\apps
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